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To turn the dot grid on and off: 

• Enable (or disable) the Dot Grid button on the View menu. 

You can also set the grid spacing, style, and colour via the Options dialog.  

Setting site properties 
Site properties allow settings to be made which will be applied across the entire 
site. Default page settings, HTML output control, search engine optimization, 
author/copyright, and web usage statistical information can all be set via the 
multi-tab Site Properties dialog. Generally speaking, decide on your Site 
property settings when you are planning your site—once set, the settings do not 
normally need to be modified (although you can at any time).  

Some site properties such as page and search-engine optimization settings are 
also mirrored on individual pages (via Page Properties; see p. 62). This lets you 
override or complement the "global" Site Properties, respectively, and apply 
"local" settings to specific pages. 

To view or change site property settings: 

• Choose Site Properties... from the File menu. The Site Properties 
dialog appears. 

The dialog is arranged into separate tabs, with each tab reflecting an aspect of 
site properties.  
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To set the site-wide page dimension settings: 

• On the dialog's Options tab, select different Width and/or Height 
values to apply to master pages. 

You can also change the default page alignment setting as a site property, or 
override it for a given page. 

To set the site-wide page alignment setting: 

• On the dialog's Options tab, select either "Left" or "Centred" in the 
Default page alignment drop-down menu. 

For more details on other tab settings, see online Help. 

Setting page properties 
Your WebPlus site has its own general framework, consisting of the site itself; 
one or more master pages; and a number of individual pages. Each aspect of 
the framework has various property settings that contribute to the look and 
behaviour or your site when it's published. Whether you start with a WebPlus 
template or from scratch, you can choose whether to stick with the default 
property settings or alter them to suit your needs. 

Page properties of individual pages can be viewed either via the Site tab, by 
right-clicking on the active page in your workspace, or via the Site Manager. 
The Site Manager offers a more powerful method of not just viewing but 
modifying the properties of multiple pages at the same time—simply check your 
chosen pages and alter one or more page properties. All checked pages will 
adopt the new settings. 

To view master page property settings: 

• Click the  Master Page Manager button above the Master Pages 
window on the Site tab. The Master Page Manager appears. 

To view normal web page property settings: 

• Right-click the page in the workspace and choose Page Properties.... 
The Page Properties dialog appears. 
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Tab name Property 

Navigation 
(default) 

Page, title, and file name 
Each page has a "visible" page name or file name shown in 
Site tab's Site Structure tree. You can edit either, as well as 
choose a title different from the page name.  

 Include in navigation 
By default, all pages are included in navigation bars. Use this 
option to exclude the page from navigation. 

 Separators and Description 
If included in navigation, check Before and/or After to apply 
horizontal separator lines above/below the page as a submenu 
item in navigation bars. A Description box adds extra page-
related text information under the bar's submenu item.  

 Active document frame 
Pages can be opened in an active document frame if the frame 
has been created previously. 

 Redirect 
After a configurable time interval a web page is redirected to a 
new hyperlink destination (another page, image, email, etc.). 

Appearance Page alignment 
Alignment determines how the page content appears in a 
browser. Use the Site's default page alignment setting (Use Site 
setting), or choose Left or Centred as an override. 

 Width and Height 
Each master page always determines the size of pages that use 
it. For individual pages that don't use a master page you can set 
custom page dimensions. For pages using a master page, only 
the Height can be changed for the page. In the Master Page 
Manager (Properties button), you can override the site setting 
for a given master page. 

Background Master pages 
Assign one or more master pages to a specific page, or set a 
page to use no master page. 

 Use Colour Scheme Designer Settings 
Adopts the site's current colour scheme settings for background 
colours or uses a custom On-Page colour and/or Background 
colour/image. 
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Effects Page Entry/Exit Transitions 
Page entry and exit transitions can be applied as you navigate 
from one web page to another. 

 Use Sound file 
Choose a background sound to load and play automatically 
when a specific page is first displayed.  

Page Security 
 

Page Security 
Apply access control to your web page(s) by assigning the 
page to a user group (via Serif Web Resources User List Smart 
object). 

Search Search engine descriptors 
Include optional descriptive information and keywords on 
individual pages, which override the site's search engine 
settings. 

Search Engine Sitemaps and robots  
Informs search engines or robots if they can crawl, analyze and 
index the current page. A Sitemap file will include the current 
page in indexing whereas a Robots meta tag (or a robots.txt 
file) will exclude the page. These settings override the site's 
search engine settings. 
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Using Site Manager 
WebPlus's Site Manager hosts a whole range of useful site-wide information 
available from a single menu-driven dialog. The tool lets you view Page/Master 
Page Properties, and pick from a selection of Management tools for viewing and 
editing hyperlinks (see below), resources, text, fonts, and much more. 

 

Powerful features of Site Manager include:  

• The ability to control the scope and to manage an individual, a 
selection or all pages in your site equally. 

• Any column can be sorted up or down which offers a quick way of 
reordering information. 

• Find and Replace. Where available, this is a powerful way of applying 
text changes across all web pages simultaneously. 

While most management tools are beneficial at any point in site development, 
the management of resources and text, as well as use of the Site Checker, are 
essential for checking your site just prior to web publishing. 

To launch Site Manager: 

• Click  Site Manager on the Hintline at the bottom of your 
workspace (or on the Pages context toolbar). 
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A quick summary gives an indication of what each management feature can do 
for you.  
 

Type of 
Management 

Lets you... 

Page/Master 
Page Properties 

Include pages in navigation (with separator control), 
assign master pages, set page alignment and size, 
rename pages, set a background, add sounds, optimize 
pages for search engines, and apply redirections, 
transitions, or access control. 

HTML Page 
Properties 

View and edit HTML page names, file names (and 
path), include pages in navigation (with separator 
control). 

Hyperlink View and edit hyperlinks, jump to hyperlinks on the 
page, find and replace destination links.  

Anchor View and edit anchor name and location, include pages 
in navigation (with separator control), jump to anchors. 

Navigation Display the navigation bars used throughout your site. 

Resource View images, media, links, HTML code resources, 
scripts, or applets in your site. Jump to each resource on 
the page, swap between linked/embedded image status, 
replace or resample images. 

E-Commerce View E-Commerce objects on pages across your site. 

Text View and edit text (in WritePlus), name stories, 
reformat text, apply styles, convert creative frames and 
tables to HTML-compatible text. 

Font View fonts and their availability, jump to fonts on the 
page, and substitute fonts. 

File Display the site structure with page file names rather 
than page names. Add files to your site. Rename and 
move file locations. 

Site checker Display common layout problems discovered in your 
site. 
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Access control 
Access control lets you apply security to your site, either to restrict access to 
specific pages or to control user access to forums and other Serif Web Resource 
features. 

 

• For page security: login to a password-protected page(s) or via an on-
the-page login box. Typically of use in personal websites or small 
enterprise websites, you can allow free access to most of your site, 
with only a limited set of pages accessible to selected web visitors. As 
an example, a Photo Gallery page of your family can be made 
"private" but still be shared with your relatives (under password 
control). The login details are stored in a user group associated with 
the page which contains a list of authorized users; the users are added 
manually by the web manager of the site or new users can self-register 
via sign up.  

• For Smart object security: provides access control for forums, blogs, 
and CMS (see p. 305). 

• Forums: for management of users and group moderation. 
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• Blogs: for adding and removing articles via an Editors group. 

• CMS: for managing articles in your CMS. 

Access control is possible via Serif Web Resources by using a User List Smart 
object, which can be created to manage user groups and users, and how users 
sign in. 

 As a brief reminder, Serif Web Resources is a secure online service 
hosted by Serif that stores Smart objects (see p. 305) and any 
generated data. You can manage your User List Smart object, as for 
any other Smart object, either from within WebPlus or via 
www.serifwebresources.com at any time. 

Successful establishment of access control on your website, is dependent on 
following the steps below. 

• Setting up your User List Smart object 

• Adding users (manual or self-registration) 

• Enabling access control 

• Adding a login box 

• Advanced user control 

Setting up your User List Smart object 

You'll need to firstly create a User List Smart object then create one or more 
groups connected to that Smart object. Normally, you'll just need one Smart 
object per site—the individual groups can then be used to control access to 
specific pages or Smart object resources.  
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To create a User List smart object: 

1. Click the  Smart Object Tool button on the Web Objects 
toolbar. 

2. Login to Serif Web Resources (See Using Smart objects; p. 305). This 
assumes you have a valid login; otherwise you will have to register. 

3. From the dialog, select the New... button at the bottom of the My 
Smart objects Library pane. 

4. In the Create Smart Object dialog, use the scroll bar to navigate the list 
of Smart objects, then select User List, then click OK. 

5. (Optional) Name your Smart object and modify colours for text, 
buttons, background, or border, then click Create. Your new Smart 
object is listed in your Smart objects Library. 
 

 

6. Click Exit to logout of Serif Web Resources. 

Once you've created your Smart object, you can create and associate user groups 
to it using the Manage feature.  

To control user signup and security: 

1. Click  Smart Object Tool on the Web Objects toolbar. 

2. With your User List Smart object selected, in the My Smart Objects 
Library pane, click the Manage button to reveal the Users dialog. 

3. To switch on self-registration user sign up to the Smart object, check 
Enable signups to User List. This allows a Sign up link to be shown 
on a placed login box. 

4. For extra security at user sign in, check CAPTCHA enabled. 
CAPTCHA is an anti-spamming technique where arbitrary server-
generated text is displayed; the web visitor enters the text for 
subsequent validation. 
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Any user can be deleted or temporarily suspended for breaking site rules (e.g., 
for posting defamatory statements on a hosted public forums). The next time the 
user tries to log on the message "Your account has been suspended" is 
displayed. 

If more drastic action is required, a user's IP address can be banned from 
accessing Serif Web Resource objects (e.g., forums, etc.). As a last resort, even 
the ISP or organization to which the owner of the email address belongs to can 
be banned from access. This latter option is not recommended normally but may 
be necessary to prevent institutional malpractice such as professional spamming. 

See online Help for more details. 

Access control with forums, blogs, and CMS 

To set up access control for forums: 

1. Select the already created User List Smart object for access control 
when creating a forum. 
 

 
 
WebPlus will automatically creates a user group, also called Golf 
Forum, to allow self-registration user sign up and sign in. The forum 
visitor will need to click the register link and sign up. 
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By default, the contents of each published web page (especially heading text) 
will be indexed. However, in an Internet world of billions of web pages all being 
constantly indexed, web developers can optimize this indexing process to allow 
a site's pages to appear higher in a user's search results. 

Optimization of web pages for search engines is possible in several ways: 

• Meta Tags: Tags store search engine descriptors (i.e., keywords and 
a description) for the site and/or an individual page. These tags are 
used to allow better matching between entered search engine text (like 
you might enter into Google) and the keywords you've associated with 
your site or page. Additionally, a robots meta tag also lets you 
include/exclude the site or pages from being indexed; hyperlinks to 
other pages can also be prevented from being explored (crawled by 
"spiders)". 

• Robots: Pages (or folders) can be excluded from search-engine 
indexing by using a robots file. This works in an equivalent way to the 
robots meta tag but uses a text file (robots.txt) to instruct robots or 
spiders what not to index. The file simply lists excluded site 
page/folder references. 

• Sitemaps: The opposite of the "robots" concept; pages can be 
included to aid and optimize intelligent crawling/indexing. site page 
references are stored in a dedicated sitemap file (sitemap.xml). 
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Whether you are using Meta tags, robots, or sitemaps independently or in 
combination, WebPlus makes configuration simple. As these settings can be 
established or modified for the whole site (Site Properties; Search Engine tab) 
any newly created page will adopt site's search engine settings. If you change the 
site settings, all web pages will update to the new settings automatically. 
However, you can override the site's settings on a specific web page (Page 
Properties; Search Engine tab) at any time. The page's override means that 
subsequent changes to site settings will always be ignored. 

Using search engine descriptor Meta Tags 

Although they're optional, if you want to increase the likelihood that your 
website will be "noticed" by major web search services, you should enter Meta 
Tag search engine descriptors. Search services maintain catalogues of web 
pages, often compiled through the use of "crawlers" or other programs that 
prowl the web collecting data on sites and their content. By including descriptive 
information and keywords, you'll assist these engines in properly categorizing 
your site. You can enter descriptors for the site as a whole and/or for individual 
pages. For example, for a simple ornithological site you could have the 
following descriptors, reflecting the content of your site or page, e.g. 
 
 Site Properties Page Properties 

Description American Birds Web Egret and Heron species page 

Keywords Birds, America, 
Audubon 

Cattle Egret, Blue Heron, Green-
backed Heron 

It's a good idea to plan which descriptors are used for the site and pages. If set, a 
site's descriptors will complement page-specific descriptors.  

To enter search engine descriptors: 

1. (For the site) Choose Site Properties... from the File menu. 
- or - 
(For a page) Right-click the page in the workspace or Site tab and 
choose Page Properties... (or choose the item from the Edit menu). 

2. Click the dialog's Search tab. 

3. In the top window, type in a brief description of your site. Although 
the description can be any length, the first ten words or so are the most 
important. 
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4. In the next window, enter any number of keywords (separated by 
commas) that you think fairly categorize your site. Put yourself in the 
place of a potential visitor. What keywords might they enter if they 
were searching for exactly what your site or page has to offer? 

5. Set a language code for your site from the drop-down menu to identify 
your site's language use. Most user's Internet search engines will 
permit language specific searches for web pages, so your site will 
show in search results according to its language code setting. 

Excluding pages from indexing (robots meta tags) 

A robots meta tag can be used by search engine robots to control how they 
access the site or page. The whole site (and pages) can be set to be indexed/not 
indexed, page hyperlinks followed/not followed, or any combination thereof. 
Site-wide settings are made by checking Index pages on this site and Follow 
links from pages or as overrides on specific page properties. 

To enable robot Meta Tag generation: 

1. (For the site) Choose Site Properties... from the File menu. 
- or - 
(For a page) Right-click the page in the workspace or Site tab and 
choose Page Properties... (or choose the item from the Edit menu). 

2. Select the Search Engine tab and check the Create robots meta tags 
option (for a page you'll need to override site-wide settings). 

3. (For the site) Use the two suboptions to allow or prevent search 
engines indexing the entire site (check/uncheck Index pages on this 
site option) or to allow or prevent indexing of all pages linked from an 
indexed page (check/uncheck Follow links from pages option). 
- or - 
(For the page) Check Override site search engine settings and 
Create robots meta tag, then check/uncheck the equivalent 
suboptions for the specific page. 
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Excluding pages from indexing (Robots file) 

The objective of this method is the same as that for using a robots meta tag, but 
instead a robots.txt file is created and no robots meta tag is included in web 
pages. The robots.txt file is stored in the web site's root folder and can be viewed 
in any text editor to verify the excluded pages and folders. 

To enable a robots.txt file: 

1. Choose Site Properties... from the File menu. 

2. From the Search Engine tab, check the Create search engine robots 
file option. 

3. (For the site) To allow or prevent search engines indexing the entire 
site (check/uncheck Index pages on this site option). 
- or - 
(For a page) From page properties, to prevent search engines indexing 
the page, check Override site search engine settings, then uncheck 
the Index this page option. 

Including pages in indexing 

So far we've looked primarily at methods of excluding web pages from 
indexing. Without these controls, web pages will be indexed by discovering 
page hyperlinks and crawling through them, harvesting keywords, descriptions, 
and page text to be indexed. However, this process may not be efficient as there 
may be a limited number of inter-page hyperlinks present throughout your site. 
As a result, a search engine sitemap file (sitemap.xml) can be created to act as a 
local lookup for crawlers to begin investigating your site. The file simply lists 
pages in your site that you've decided can be indexed. The file also indicates to 
search engines when pages have been modified, informs when the search engine 
should check the page and how "important" pages are in relation to each other. 

The Sitemap method is especially good for "advertising" your site pages—with a 
greater likelihood of your pages appearing high in a user's search results. 

Just like the robots file, the setting of site and page properties creates the sitemap 
file (this is published with your site); the file is stored in the root web folder 
(perhaps alongside a robots.txt file). 
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 One requirement of using search engine sitemaps is the need to 
declare an absolute URL. This allows the proper URL address (e.g., 
www.helloworld.com) to be indexed, allowing search engine users to 
link through to your site from their search results. 

To enable search engine sitemaps: 

1. Choose Site Properties... from the File menu. 

2. Check the Create search engine sitemap file option. 

3. (Optional) When the above option is checked, the default sitemap.xml 
file can be renamed. Click the Change... button and edit accordingly. 

4. (For the site) To populate the sitemap file with a list of all the site's 
web pages (for improved page "discovery"), the Index pages on this 
site option is checked. Uncheck to create an empty sitemap.xml file. 
- or - 
(For a page) From page properties, to add the page to the sitemap file, 
check Override site search engine settings, then check the Index 
this page option. This assumes the site as a whole has not been listed 
in the sitemap.xml file. 

5. Check/uncheck Sitemap settings including: 

• Page's last modified date and time. 

• Page change frequency (set drop-down menu to hourly, daily, 
weekly, monthly, yearly, or never): This suggests to the search 
engine how frequently the page is likely to change. The search 
engine will decide how often to index the page on the basis of 
this setting. 

• Page priority rating: 0.0 (lowest) to 1.0 (highest). Sets a page 
priority relative to your other web pages by which search engines 
are most likely to index. The default can be set on site properties 
with specific page overrides setting a priority higher or lower 
than the default. 
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Prioritizing text with Heading HTML tags 

It is possible to assign paragraphs (or text styles) in your HTML frame or 
HTML table with a preferred HTML tags (H1, H2, .., to H6) for export. The tags 
can be assigned from Paragraph... on the Text menu (choose the 
Paragraph>HTML option); simply pick a preferred HTML tag for your 
paragraph from the drop-down menu. An advantage of this is that paragraphs 
assigned such tags take priority over other "body" tags (e.g., those using the <P> 
tag) when appearing in search engine results (the H1 tag is the highest priority). 

Searching websites 
WebPlus uses a powerful search facility which matches user search terms with 
text that appears in your site in artistic text, HTML/creative text frames or 
tables. This makes it easy to retrieve content from any hosted web pages. 

The search feature works by using the Site Search Tool and Site Search 
Results Tool, both hosted on the Web Objects toolbar's Search flyout. Each 
tool is used to create objects that work together in combination.  

 

Site Search Results object—creates 
a window in which the search results 
are displayed. Typically, this is 
placed and sized onto its own page, 
and does not appear in the site 
navigation structure.  

You'll normally position the search 
results box ahead of adding the Site 
Search object. 

 

Site Search object—the text box in 
which users type the word or phrase 
they want to search for. This text 
box is usually added to a master 
page and appears on all pages of the 
site. 

As an example, the above search term "vitae" could retrieve search results 
showing web pages which contain the search term. The user clicks the Search 
button to initiate any search.  
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The search results show a hyperlinked page name heading plus associated web 
page text for reference. Simply click the hyperlink to access the web page. 

With respect to security, all web pages will be searchable by default. However, 
password-protected pages will always be excluded from search results. See 
Access control on p. 67 for more information on password protection. 

To add Site Search Results: 

1. Click the  Site Search Results Tool on the Web Objects 
toolbar's Search flyout. 

2. Move the  place cursor to a chosen position, then click and drag 
to place your search results window.  

To add the Site Search object: 

1. Click the  Site Search Tool on the Web Objects toolbar's Search 
flyout. 

2. On the web page or master page, move the  place cursor to a 
chosen position and click to place your Site Search object. Your 
search object appears on the page. 
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 Add the search object to the top of your master page to allow site-
wide access to the search feature.  

Site search is useless without some means of displaying the search results to the 
user. This is possible by using the Site Search Results object which, like the Site 
Search object, can be placed on a web page under a place cursor. However, the 
object is typically resized to full page size before placement (it needs to display 
multiple web page hits consecutively). 

 Keep the search results on a separate, perhaps new, page which 
can also have its own look and feel (double-click the object to alter 
page appearance). 

Using the Gallery 
The Gallery tab serves as a container for storing your own design objects you'd 
like to reuse in the same or different websites. Once you've copied a design to 
the Gallery, it becomes available to any site—simply open the Gallery! 

Additionally, the tab includes categorized pre-designed elements such as Flash 
banners that you can customize and use as a starting point for your own designs 
(you'll get even more design categories and elements if you purchase and install 
the WebPlus X4 Resource CD).  

The Gallery has two parts: an upper Categories drop-down menu and a lower 
Designs window showing a list of thumbnails representing the designs in the 
selected category. You can adopt a design by dragging the thumbnail onto the 
page. 
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The Gallery tab can store your own designs in the ready-to-go My Designs 
category—the design is made available in any WebPlus site. When you first 
install WebPlus, the My Designs gallery will be empty, ready for custom 
designs to be added to it. New categories can be created at any time. 

To further arrange your designs into logical groupings, you can add sub-
categories to My Designs or to any other custom or pre-defined category. 

 Designs can be added to any pre-supplied category; the My Designs 
category exists simply for ease of use when storing your own 
custom designs. 

To use a design from the Gallery: 

• Click its thumbnail in the design category and drag it out onto the 
page. The Gallery retains a copy of the design until you expressly 
delete it. 

To view your Gallery: 

1. Click the Studio's Gallery tab. 

2. Select a category from the drop-down menu. The items from the first 
listed subcategory are displayed by default. 

To add, delete, or rename custom categories: 

1. With the Gallery tab selected, click the  Tab Menu button and 
choose Add category..., Delete category, or Rename category... 
from the flyout menu. 

2. Use the dialog to enter and/or confirm your change. 

If adding a category, you need to name the category in a dialog. For renaming or 
deletion, simply pick the category in advance of picking the option. 

 All designs in a deleted category will also be lost.  
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To add, delete, or rename custom sub categories: 

• To add, select a category and click Add Sub Category... from the 
tab's  Tab Menu button. 

• To delete or rename, select options from the  drop-down button on 
the sub category title bar. 

To move or copy an object into the Gallery: 

1. Using the Categories drop-down menu, select a category into which 
you want to add the object. Scroll to reveal target sub-categories, 
expanding them if necessary. 

2. Drag the object from the page and drop it onto the target category or 
sub-category design window (drag onto an empty sub-categories title 
bar to add). To copy, press the Ctrl key before starting to drag. A 
thumbnail of the design appears in the Designs window. 

To rename or delete a custom design from the Gallery: 

• Click on the  drop-down button in the bottom-right corner of a 
thumbnail (shown by hover over) and choose from the menu. 

Adding Google maps 
Use embedded Google Maps in your web page if want to make sure that a client 
can locate your headquarters, attendees can find that special meeting (or event), 
or identify special interest locations. By embedding in a purposely designed 
"Directions" web page, you'll be able to add the map and written supporting 
directions to your site accordingly. 
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Each map will allow up to 10 markers to be placed on the map to identify each 
location. 

A more advanced Map feature is also available for more complex mapping 
requirements, including an unlimited number of markers and the ability to use 
HTML as your marker text. 

To add a simple Google map: 

1. Click  Insert Google Map on the Web Objects toolbar's Media 
flyout. 

2. From the Configure Google Map dialog, enter your zip code, post 
code, or address in the Search for a location field. As Google's 
geolocator is being used, WebPlus will sense your locale, and display 
local addresses preferentially. 

3. Navigate around the map using supporting panning and zoom 
controls—drag the hand cursor to pan, the zoom slider and buttons to 
magnify/zoom out. If you've got a mouse with a scroll wheel, check 
the Enable mouse scroll wheel zoom for quicker map navigation. 

4. To add a marker, click Add, and then place the  cursor over the 
chosen location, then click. 
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5. In the dialog, enter a Marker name and text for the marker, and click 
OK. The marker appears on the map preview, and its text will show 
when the marker is clicked. Repeat the process for each marker in 
turn.  

6. (Optional). Enable Show Navigation Control buttons for either Full 
(panning, Zoom buttons, and Zoom slider) or Compact modes (+/- 
zoom in/out buttons only). 

7. (Optional). Enable Show Map Type Control buttons for either a Bar 
or drop-down Menu (both showing Map, Satellite, Hybrid, and Terrain 
modes). 

8. Click OK. 

9.  You'll see the mouse pointer change to the Paste cursor. What 
you do next determines the initial size and placement of the map. 

• To insert the map at the default size, simply click the mouse. 
- or - 
To set the size of the map to better fit your page design, drag out 
a region and release the mouse button. 

At some point, you may want to move or delete a marker by editing the Google 
map. 

To edit your Google map markers: 

• Double-click the Google map on your page. 

• From the dialog, select a marker from the Map Markers drop-down 
list, then: 

• To edit the marker label, edit the text in the Label scrolling box. 

• To move the marker, click Move, then place the  cursor on 
the map again. 

• To delete the marker, click Remove. 
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Using Advanced Google Maps 

Try the Advanced Google Maps if you've a need for greater than 10 map 
markers and are interested in adding labelling and marker text that can contain 
HTML code, with supporting hyperlinks and images.  

You'll need to acquire a site-wide Google Maps key to enable this feature. Only 
one key is allowed per site. 

To enable Advanced Map mode:  

1. Check Use Advanced Maps. 

 You'll now need to register for a Google account and then obtain a 
site-wide Google API key first! 

2. Click the Go to Google Maps website button to sign up for a key. 

3. Paste your copied key from the Google.com website into the dialog's 
Google Maps key text box. 
 

 

4. To enter HTML code, type directly into the Label field. For more 
advanced coding, consider copying and pasting HTML code into the 
field which has been developed independently of the Google Maps 
dialog. 

5. Click OK. 

 To see your changes, you'll have to publish your site (see p. 319). 
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Adding advertising 

 

Google Adsense is a free Google service which 
allows you to place advertising space on your 
web pages. Visitors to your pages will be 
served adverts according to the type of content 
your site is publishing—the visitor benefits 
from easy access to tailored shopping 
opportunities while you, as web developer, earn 
money to offset the cost of hosting or to get rich 
quick! 

To advertise, web developers must have an approved Google Adsense account 
(www.google.com/Adsense), where you'll be able to create and manage up to 
three adverts per page, each advert being called a unit. You can copy and paste a 
generated code snippet per unit from the Google Adsense website and paste it 
into WebPlus's Google Adsense advertisement dialog. 

Supported advert formats range from Leaderboard (728x90 pixel), Banner 
(468x60), Half Banner (234x60), Button (125x125), to various Skyscraper, 
square, and rectangular sizes.  

Google Adsense also offers comprehensive usage reports, account management, 
and supporting resources. For more information, visit www.google.com/adsense.  

To log in to Google Adsense: 

• Visit www.google.com/adsense to sign up or sign in to Google 
Adsense. Click the Sign Up Now button if you're a new user or simply 
login using your existing user details; new users will be asked to enter 
your site's URL, language, and agree to Google's terms and conditions. 
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 When you register, you'll have to wait for Google to check that your 
website is considered suitable. You'll be contacted by email within 
one week with Google's response. If successful, you can then create 
and manage adverts. 

 The registration process will analyze your website and provide 
advertising suitable to your website content. The web developer is 
not in control of specific advertising content. 

To create and manage adverts: 

1. Login to Google Adsense. 

2. From Adsense Setup, choose Adsense for Content, then follow the 
wizard to create an ad unit, select its format, and colour style. 

3. Copy the generated Adsense unit code snippet provided for the ad 
unit. You'll need this to paste into WebPlus. 

To embed adverts in your web page: 

1. Select a web page (or master page) on which you want to place your 
advert. 

2. Click  Embed Google Adsense advertisement on the Web 
Objects toolbar's E-Commerce flyout. 

3. Paste the code snippet previously copied for the unit by clicking Paste 
from Clipboard. The snippet appears in your dialog and cannot be 
edited.  
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• Item ID: Add an easily identifiable string to track the item 
through PayPal. 

• Currency: Set the currency in which the transaction will be made 
in. 

• Price: The price for the item. Shown on-screen by default. 

• Allow customer to specify the amount: Check to swap the 
above Price for a box in which the web visitor can enter their 
own price. Use with donation forms, where the customer sets the 
amount. 

• Override the tax settings..: Check to override provider's 
profile's tax setting for the item. If checked, specify a flat tax rate 
for the item, e.g. 0% for tax-free charitable donations. 

• Weight: Set an item weight if you're using weight-based shipping 
(US only), set in your PayPal profile. Typically, pounds (lb) are 
used as measurement, but kilograms (kg) can also be set if 
needed.  

Choose from the above settings and click Next>. 
 
If you're using e-commerce database merging, this Item Details dialog 
will instead let you choose an e-commerce database for use with your 
chosen provider. Remember to set the currency you wish to trade in. 

7. For e-commerce forms only, two subsequent dialogs are shown: 

• The Item Description dialog lets you optionally include an image 
(e.g., to preview the item for sale), and short and long 
descriptions that will show in the form. Click Next>. 

• The Item Options dialog lets you create edit boxes, combo boxes, 
radio buttons, and fixed names (up to 10 options can be selected 
per form in PayPal; only one price-changing option) as 
appropriate—you can design from scratch or use previously 
saved options fields. Click Next>. Not shown for repeating 
forms. 
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8. In the Item Details dialog, set a default quantity in the input box, or 
check the box to let the user specify an amount at checkout (not shown 
for repeating forms).  
- or - 
Set the Add Edit box option to let the customer define the quantity to 
be ordered. 
 
For shipping and handling associated with the order, enter a set 
amount for Handling, Shipping, and Extra Shipping charges. 
If left blank, the default PayPal's profile will be used instead. Not 
shown for repeating forms. Click Next>.  

9. In the Extra Customer Information dialog, choose to prompt the 
customer for an address, don't prompt, or require the customer to enter 
an address. Optionally, ask a question of the customer in the text box. 
Click Next>. 

10. The Payment Pages dialog offers some payment settings, i.e. 

• Enter the name of your Checkout Page Style (if setup in advance 
via your PayPal login). 

• Set a language for the PayPal login page. Pick for the drop-down 
list. 

• Change the text for the Continue button on the Successful 
Payment Page. 

• If needed, define Successful Payment Pages and/or Cancelled 
Payment Pages. Enter the page's URL or select an entry from the 
drop-down list. 

11. For e-commerce forms only, choose a form layout from the Form 
Layout dialog. Several check box options let you control what gets 
shown on the form layout. You can disable price, and if repeating area 
forms are used, hide/show the item image, short/long descriptions, 
fixed options, and a dummy quantity edit box. Forms can be 
reformatted with the Reformat form now check box.  

12. Click Finish. 
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13.  To insert the form or button, position the cursor where you 
want it to appear on the page, then simply click the mouse. 

To edit an e-commerce form or button: 

1. Select the form, right-click the form and choose Edit E-Commerce 
Form.... 
- or - 
Select the button, right-click the button and choose Edit E-Commerce 
Button.... 

2. Modify e-commerce settings screen-by-screen in the displayed dialog. 

To convert to a standard form: 

• Right-click on the existing e-commerce form and choose Convert to 
Form. 

Smart objects 

Using Smart objects 

For modern interactive web features (counters, forums, blogs, resource booking, 
and more), WebPlus uses server-sided Smart objects placed on the page. Smart 
objects store gathered web visitor data on Serif's own secure server space. These 
objects are available from Serif Web Resources, a secure online online service 
for not just creating and inserting smart objects, but for storing and managing 
object data once your site is published and live. 

Let's look at each Smart object you'll find in Web Resources and what you can 
do with them. 
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Name Use 

 
Active Viewers 

Use to show how many people are currently viewing 
the web page. 

 
Blog 

A blog acts as a personal journal on your web page 
which hosts your own published articles in an easy-to-
use RTF editor. Articles can be commented on by 
visitors to the web page. With blogs you can: 

• Add your own personal profile. 

• Add social bookmarking links. 

• Use article trackbacks for inter-blog cross-
referencing; use receive trackbacks. 

• Use tagging to categorize articles for easier 
user access. 

• Enable users to subscribe to articles (most 
recent articles/comments) via RSS feed 
readers. 

• Enable CAPTCHA anti-spam protection. 

• Apply a Visual Styles (theme) to your blog. 

• Use Editor groups for multi-author article 
publishing (see p. 76). 

 
Forum 

Add a thread-based discussion forum to your site, 
optionally in a full-sized window. With forums you 
can:  

• Under different categories (e.g., Motoring) 
add multiple subforums (Classics, 
Convertibles, Custom, etc.). 

• Establish access control for users and 
moderators (see p. 76). 

• Set forum privacy as publicly readable or 
private. 

• Apply a theme (style) to the overall forum 
object. 

• Create, edit, and assign user ranks. 

• Set user permissions. 
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Users can view number of topics, posts, and last post 
submitted, and obviously post to the forum. 

 
Hit Counter 

A straightforward count of the number of hits on the 
current page (reset as needed). Different styles can be 
adopted. 

  
News 

Add a news window onto your page. The object 
supports RTF editing as well as paragraph styles, 
hyperlinks, inserted media, and HTML source editing.  

 
Poll 

Set up an online poll to canvass web visitor's opinions. 

 
Content 
Management 
System (CMS)  

Lets the web developer add content to web pages 
remotely without accessing and publishing via 
WebPlus. Content is article-based where articles can be 
categorized, created, edited, deleted and arranged into 
categories. Site visitors can comment on and rate any 
article.  

 
Resource 
Booker  

Host the online booking of hotel rooms, meeting 
rooms, rehearsal rooms, theatre tickets, and more. 
Book by the hour or by the day, as recurring bookings, 
and with pricing options for different age groups. 

 
Shout Box 

Acts as an interactive chat window similar to Windows 
Messenger. Let your web visitors chat amongst 
themselves. 

 
User List 

The User List Smart object operates in two modes: 

• Mailing List mode: Have website visitors sign up 
to newsletters, party confirmations, information 
request, and many more. Lists can be controlled 
manually or by self-subscription.  

• Access Control mode: Control accessibility to 
pages, forums, blogs, and CMS by using user 
groups. See Access Control on p. 67. 

• Enable CAPTCHA anti-spam protection 
during user registration. 
 
 

























Previewing and Publishing 319 

   

• Total size: (e.g., 153 KB) 

• Download time on a 56k modem: (e.g., 40 seconds) 

• Download time on 512k ADSL broadband: (e.g., 4 seconds) 

Publishing to the web 
Publishing to the web involves uploading your completed site to your web host 
provider, turning your site into a live website, viewable by the whole world! 
You can specify that all web page are published or, if updating your site, only 
pages changed since the last "publish." 

Before publishing to the web, it is worth checking for potential problems by 
running the Site Checker (Tools>Site Manager>Site Checker...). 

 Remember that you can publish to disk folder at any time, which 
lets you test your website offline (and locally) before publishing to 
web. See online Help for more details.  

To publish your site to the web: 

1. Choose Site Properties... from the File menu and double-check 
export settings, particularly those on the Graphics tab.  

2. Click the  Publish site button on the Standard toolbar (or choose 
Publish Site from the File menu and select Publish to Web... from 
the submenu). 

If this is your first time publishing to the web, you'll see a Publish to Web 
dialog without any account information present (you'll see your local site ready 
to upload). You'll need to set up at least one FTP account with your chosen ISP 
before you can proceed. 

1. Click the Accounts... button to display the Upload to Server dialog. 

2. Click Add... 

3. In the Account Details dialog, enter: 
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To activate web hosting: 

1. Either: 

1. Click the  Smart Objects Tool on the Web Objects toolbar. 

2. In the dialog, click My Hosting. 
 
- or - 

1. Click the  Publish site button on the Standard toolbar (or 
choose Publish Site from the File menu and select Publish to 
Web from the submenu). 

2. In the dialog, click WebPlus.net Hosting.... 

2. From the Serif Web Resources dialog, choose various hosting option 
according to requirements: 

• Choose a password. 

• (Optional) Input your supplied Coupon code for your web 
hosting package (if purchased as an upgrade).  

• Choose a Subdomain name, e.g. <mysite>.webplus.net, where 
<mysite> is your chosen website name. 

• Select your Region (e.g., Europe, North America, etc.). This is 
the region in which your website will be hosted, so if you're 
targeting European users keep with the Europe option. 

3. Click Create Hosting. 

Your site can now be uploaded via Publish to Web or Quick Publish to Web 
on the Standard toolbar. 

 If you have an FTP account already set up as default in WebPlus, 
the new Serif web hosting account will become the new default. See 
Setting site properties (Publishing tab) on p. 59. 
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2D 

filter effects, 175 
3D 

filter effects, 179 
Instant 3D, 181 

access control, 67, 307 
adding users in, 71 
for Smart objects, 76 
signing up to, 73 
user groups in, 70 

Active Viewers (Smart object), 
306 

adjunct colours, 241, 242 
adjustment (of pictures), 208 
advertising (Adsense), 91 
albums 

in Media Bar 
creating, 202 

aligning 
objects, 155 

with grid or guides, 157 
paragraphs, 119 

Analytics, 308 
Anchor Manager, 66, 255 
anchors, 251, 254 

hyperlinking to, 251 
animation effects, 220 
anti-spam (CAPTCHA), 285 
artistic text, 105 

on a path, 108 
Artistic Text Tool, 106 
attaching 

HTML to objects, 273 

objects to text, 159 
audio files, 223, 225 
automatic publishing, 323 
Back One command, 155 
background, 242 

sound, 225 
bevel effect, 175 
bitmap 

fills, 245 
transparency, 246 

Blog (Smart object), 306 
accessing, via offsite links, 40 

blur effect, 176 
borders, 184 

custom, 186 
Bring to Front command, 155 
browser preview, 317 
bulleted lists, 125 
cache 

clearing, 324 
Calendar Event Manager, 134 
Calendar Wizard, 135 
calendars, 134 

events for, 136 
inserting, 135 
public holidays for, 136 

CAPTCHA (anti-spam), 285 
Choose Workspace, 20 
Clear Formatting, 119 
Clipboard 

copying and pasting to or from, 
144 

CMS (Smart object), 307 



Index 

 

colour 
gradient fill, 245 
schemes, 239 
solid fill, 237 
tinting, 238 

Colour Scheme Designer, 239 
Colour Schemes 

assigning, 243 
modifying, 243 
presets, 241 

Content Management System. See 
CMS 

copying and pasting objects, 144 
counters, 307 
Creative Frame Tool, 101 
Creative Table Tool, 133 
Crop to Shape, 152 
cropping objects, 150 
Curved Path Text Tool, 109 
defaults, 163 

saving global, 164 
updating, 163 

design template, 20 
digital cameras, 207 
dimensionality (Instant 3D), 181 
dot grid, 58 

snapping to, 157 
draw-type pictures 

importing, 195 
duplicating objects, 145 
dynamic guides, 157 
e-commerce, 299 

adding forms and buttons 
(PayPal), 300 

configuration, 300 

shopping cart 
hyperlinking to, 251 

E-Commerce Manager, 66 
effects 

2D filter, 175 
3D filter, 179 
outline, 177 
pictures, 208 
reflection, 177 
shadow, 178 

embedding vs. linking, 199 
emboss effect, 175 
events (calendar), 136 
export options (pictures), 203 

for individual graphics, 205 
favourites 

filter, 214 
feather effect, 176 
features 

key, 4 
new, 10 

File Manager, 66 
Fill Tool, 245 
fills 

bitmap, 245 
gradient, 245 
solid, 237 

filter effects, 175, 179 
filters (photo), 208 

applying, 210 
committing, 211 
favourite, 214 
masking with, 212 

Find and Replace, 114 
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Fit Text to Curve, 109 
Flash 

banners, 85 
movies, 220 
navigation bars, 46 

Font Manager, 66 
fonts, 119 

setting, 119 
WebSafe, 120 

formatting text, 119 
Paste Format for, 146 

forms, 275 
controls, 281 

editing, 284 
creating, 278 
structure, 276 
submission of, 284 

acknowledging, 285 
Forums (Smart object), 306 

accessing, via offsite links, 40 
Forward One command, 155 
frame text, 98 
frames (picture), 193 
frames (text), 98 

creating, 101 
Creative, 100 
HTML, 100 
margins/columns of, 102 
setting default properties, 163 
snapping to, 157 

Freehand Path Text Tool, 109 
FTP 

account details, 319 
migrating, 322 

FTP settings, 319 
Gallery tab (Studio), 85 
glow effect, 175 
Google AdSense, 91 
Google Analytics, 10 
Google Maps, 87 
gradient 

colour fills, 245 
transparency, 246 

groups, 162 
guides, 54 

dynamic, 157 
ruler, 55 
snapping to, 157 
sticky, 56 

hexadecimal colour code, 238 
Hit Counter (Smart object), 307 
holidays (public), 136 
home page, 29 
hotlinking, 234 
hotspots, 255 

editing, 256 
HTML, 267 

adding code to Web pages, 269 
attaching code as fragments, 

273 
creating pages in, 267 
IDs, 274 
tokens, 275 

HTML Frame Tool, 101 
HTML pages, 40 
HTML Table Tool, 133 
Hyperlink Manager, 66, 253 
hyperlinks, 251 

setting colour of, 242 



Index 

 

IDs 
HTML, 274 

Image Cutout Studio, 215 
Image Export Manager, 204 
importing 

pictures, 195 
text, 97 
TWAIN images, 207 

Include in Navigation, 52 
indents, 112 
inline pictures, 196 
installation, 14 
Instant 3D, 181 
Internet Service Provider (ISP), 

319 
Irregular Crop Tool, 151 
iTunes, 289 

submission of podcasts to, 294 
subscribing to, 294 

JavaScript, 271 
navigation bars, 46 

joining outlines, 153 
key features, 4 
layout aids, 54 

dot grid, 58 
dynamic guides as, 157 
ruler guides, 55 
snapping, 157 
sticky guides, 56 

Learning Zone, 20 
letter spacing, 119 
lighting (3D), 181 
linear fills, 245 
linear transparency, 246 
lines, 167 

changing colour or shading, 237 
drawing, 168 
editing, 170 
fitting text to, 108 
resizing, 147 
setting default properties, 163 
setting properties, 170 

linking vs. embedding, 199 
lists 

bulleted, 125 
numbered, 125 

mailing lists, 307 
maps (Google), 87 
marquees, animated, 220 
masking (for picture 

adjustment/effects), 212 
master pages, 32 

adding, 41 
assigning, 42 
multiple, 43 
properties, 62 
rearranging, 42 
removing, 41 

Media Bar, 200 
metafiles, 195 
multiple selections, 142 
navigation, 31 

and site structure, 29 
bars 

hyperlinking to, 251 
excluding pages from, 51 

navigation bars, 29, 45 
adding, 47 
checking, 53 
creating, 46 
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customizing, 49 
dynamic, 53 
editing, 48 
styles, 50 

Navigation Manager, 53, 66 
new features, 10 
News (Smart object), 307 
numbered lists, 125 
objects 

aligning, 155 
attaching code to, 269 
combining, 152 
copying, pasting, and 

replicating, 144 
cropping, 150 
defaults for, 163 
joining, 153 
measuring, 58 
moving, 146 
ordering, 155 
resizing, 147 
rotating, 148 
selecting individual, 141 
selecting multiple, 142 
snapping, 157 
styles, 187 

saving, 189 
offsite links, 40 

adding, 40 
on-page colour, 242 
opening an existing site, 25 
outline effect, 177 
outlines 

joining, 153 
Page Locator, 35 

page margins, 54 
page security, 64 
pages 

adding, 37 
attaching code to, 269 
background colour, 242 
background sound, 225 
caching problems, 324 
cloning, 41 
default size/alignment for, 61 
hyperlinking to, 251 
on-page colour, 242 
optimizing, for search engines, 

77 
parent and child, 30 
properties of, 62 
rearranging, 42 
security, 67 
selecting and viewing, 35 
setting size for, 62 
switching between page and 

master page, 36 
viewing, 33 

paint-type images, 195 
importing, 195 

Pan Tool, 34 
paragraphs 

alignment, 119 
formatting, 119 

parent/child pages, 30 
Paste Format, 146 
Paste Format Plus, 146 
Paste in Place, 144 
pasting objects, 144 
path text, 108 
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PayPal 
adding forms and buttons to, 

300 
configuring, 299 

PDF, 326 
Pen Tool, 167 
Pencil Tool, 167 
Photo Gallery, 229 

creating, 230 
editing, 233 

PhotoLab, 208 
launching, 210 

picture frames, 193 
pictures 

adjustments for, 208 
borders for, 184 
cropped 

adjusting, 198 
frame properties of, 199 

effects for, 208 
export options for, 203 
hyperlinking to, 251 
importing, 195 
inserting, 196 

via Media Bar, 203 
linking remote, 234 
Media Bar for, 200 
optimizing, 203 
popup, 259 
replacing, 197 
resampling, 207 

podcasts, 289 
adding episodes to, 292 
adding to page, 297 
creating, 291 

hyperlinking to, 251 
iTunes submission of, 294 
subscribing to, 294 

point size, 119 
Pointer Tool, 141 
Poll (Smart object), 307 
popup rollovers, 259 
previewing 

customize browsers for, 317 
sites, 317 

profiles 
Smart object, 310 
workspace, 20 

proofing tools 
Site Manager, 65 

properties 
site, 59 

publishing 
to web, 319 

Quick Publish, 325 
to PDF, 326 

to Web 
automatic, 323 

Quick Publish, 325 
configure, 325 

QuickShapes, 173 
radial 

gradient, 245 
transparency, 246 

raster images 
importing, 195 

reflection effect, 177 
Registration Wizard, 3 
remote images, linking to, 234 
Replicate, 145 
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resampling, 206 
Resource Booker (Smart object), 

307 
Resource Manager, 66 
retouching (pictures), 212 
reverting to saved version, 25 
robots, 78 

using robots meta tag, 80 
using robots.txt, 81 

rollovers, 257 
popup, 259 

Rotate Tool, 148 
rotating objects, 148 
RSS Feed Manager, 293 
RSS Feed Tool, 291 
RSS feeds, 289 

adding articles to, 292 
adding to page, 297 
creating, 291 
hyperlinking to, 251 
subscribing to third-party, 294 

RSS Reader Tool, 296 
ruler guides, 55 
rulers, 56 
saving a site, 26 
scanned images 

importing, 207 
schemes (colour), 239 

modifying, 243 
search engines, 77 

descriptors, 77 
robots meta tag for, 80 
robots.txt for, 81 
sitemaps for, 81 

searching websites, 83 

selecting objects, 141 
Send to Back command, 155 
Serif web hosting, 327 
Serif Web Resources, 285, 305 

clearing account details, 309 
creating account for, 308 
login, 309 

Shade/Tint slider, 238 
Shadow Tool, 178 
shapes 

closed, 174 
drawing and editing, 172 
fitting text to, 108 
gradient/bitmap fills for, 245 
resizing, 147 
setting default properties, 163 
solid fills to, 237 
transparency for, 246 

Shockwave Flash movies, 220 
shopping cart, 299 

configuring, 299 
Shout Box (Smart object), 307 
signing in (access control), 75 
signing up (access control), 73 
Site Checker, 66 
Site Manager, 65 
site map (navigation), 46 
Site Search Results Tool, 84 
Site Search Tool, 84 
site structure 

and navigation, 29, 45 
offsite links, 40 

Site Structure tree, 29 
Site tab (Studio), 30, 33 
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sites 
opening existing, 25 
previewing, 317 
properties of, 59 
saving, 26 
starting from scratch, 24 
structure, 29 
working with multiple, 26 

size 
of objects, 147 

Smart Object Tool, 69 
Smart objects, 305 

access control for, 76 
creating, 309 
deleting, 314 
editing, 312 
exporting, 313 
hyperlinking to, 251 
managing, 312 
profiles for, 310 
security for, 67 

snapping, 157 
solid colours, 237 
sound 

adding, 224 
adding to Web page, 225 
hyperlinking to, 251 

sound, 223 
Square Crop Tool, 151 
Startup Wizard, 19 
sticky guides, 56 
story text 

flowing in frame sequence, 104 
Straight Line Tool, 167 

Straight Path Text Tool, 109 
styles 

font, 119 
HTML-compliant, 83 
object, 187 

saving, 189 
text, 121 

Styles tab, 176 
submission (of forms), 284 
swf files, 220 
system requirements, 14 
tab 

Transparency, 247 
tables, 131 

Creative, 131 
HTML, 131 

template (design), 20 
adding pages from, 38 
creating site with, 20 

text 
adding to text frame, 98 
artistic, 105 
attaching objects to, 159 
bullets and numbering, 125 
changing colour or shading, 237 
creative text frames, 98 
editing, 110 
formatting, 119 
frame, 98 
HTML text frames, 98 
importing from file, 97 
on a path, 108 
resizing, 147 
setting default properties, 163 
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special effects, 175, 179 
Unicode, 114 
using gradient and bitmap fills, 

245 
Text Manager, 66 
text styles, 121 
theme layouts, 20 
tinting, 238 
tokens 

for HTML, 275 
Tool 

Artistic Text, 106 
Creative Frame, 101 
Creative Table, 133 
Fill, 245 
HTML Frame, 101 
HTML Table, 133 
Instant 3D, 183 
Irregular Crop, 151 
Pen, 167 
Pencil, 167 
Pointer, 141 
Rotate, 148 
RSS Feed, 291 
RSS Reader, 296 
Shadow, 178 
Site Search, 84 
Site Search Results, 84 
Smart Object, 308 

Square Crop, 151 
Straight Line, 167 
Transparency, 247 

Transform tab (Studio), 146, 148 
transparency, 246 
Transparency tab, 247 
Transparency Tool, 247 
typeface, 119 
User List (Smart object), 68, 307 
vector images 

importing, 195 
video, 223 

adding linked, 224 
adding YouTube, 224 
hyperlinking to, 251 

view source, 270 
View toolbar, 34 
web hosting, 327 
web pages 

hyperlinking to, 251 
WebPlus hosting, 20 
WebSafe fonts, 120 
Welcome, 3 
Window tabs, 26 
word processor files, 97 
workspace profiles, 20 
YouTube video, 224 
zoom view options, 34 
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